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1 Introducing the GNSS Control Panel 

 

The GNSS Control Panel enables the use of a wide range of 
professional GNSS receivers for applications requiring the level of 
precision permitted by GNSS post-processing with EZSurv®. 

 

The GNSS Control Panel can be used as a standalone data collector 
or as a GNSS driver platform for applications such as the GNSS 
Driver for ArcPad. 

 

Application software developers can build GNSS applications on top of 
the GNSS Control Panel SDK, available separately. 

 

The GNSS Control Panel work on Windows computers as well as on 
Windows Mobile devices. 

 

 

This guide describes how to use GNSS Control Panel. 

 



 

 
OnPOZ.com 2 GNSS Control Panel

 
User Guide 

GNSS Control Panel // Precision Positioning Platform 

User Guide 

1.1 Overview 
The GNSS Control Panel provides the foundation applications and technologies to enable GNSS data collection 
compatible with EZSurv®. 

 

This includes: 

• The GNSS Universal Driver, a powerful GNSS driver that supports a wide range of GNSS receiver 
protocols for use with the EZSurv® post-processing software; 

• The GNSS Control Panel, an easy-to-use application for configuring the connection to you GNSS receiver 
and for performing simple GNSS data collection tasks; 

• The GNSS Control Panel SDK, a software development kit available separately (contact OnPOZ Sales 
for details). 

 

� GNSS Universal Driver 

The GNSS Universal Driver is the proven technology that drives EZTag CE™ since 1995. It is now available as a 
standalone engine, distributed as part of the GNSS Control Panel. 

See the GNSS Control Panel Release Notes for the list of supported GNSS protocols and receivers. 

All drivers are compatible with the EZSurv® post-processing software. 

 

� GNSS Control Panel 

The GNSS Control Panel provides the user interface to connect to your GNSS receiver, to perform some simple 
data collection tasks, and to configure the GNSS receiver profiles. 

   

 

� GNSS Control Panel SDK 

The GNSS Control Panel SDK allows application software developers to create new GNSS applications on top of 
the GNSS Universal Driver. For instance OnPOZ offers such an application called the GNSS Driver for ArcPad. 
Please contact OnPOZ Sales for more information about the SDK. 
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Chapter 2 

 

2 Connecting to the GNSS Receiver 
This chapter introduces the basics about connecting to your GNSS receiver and monitoring status information. 
This is useful if you plan to collect data using the GNSS Control Panel. 

 

A Note to ArcPad Users 

If you plan to use the GNSS Driver for ArcPad as your data collector then please refer to the GNSS Driver for 

ArcPad User Guide for details about how to connect to your GNSS receiver under ArcPad. We recommend 
that you read this chapter anyway, as it contains useful information. 

 



 

 
OnPOZ.com 4 GNSS Control Panel

 
User Guide 

GNSS Control Panel // Precision Positioning Platform 

User Guide 

2.1 Starting the GNSS Control Panel 
This section shows how to start the GNSS Control Panel and how to recognize possible states of the GNSS 
Universal Driver. 

Start menu: 

 

To start GNSS Control Panel on Windows: 

• Select OnPOZ > GNSS Control Panel from the Windows Start menu. 

Programs: 

 

To start GNSS Control Panel on Windows Mobile: 

• Click Programs under the Start menu, then click then select the GNSS 
Control Panel icon: 

 

 

 

A click on the GNSS Control Panel Status Icon opens the GNSS Control Panel 
application. 

 

If the GNSS Universal Driver is not currently started, the status bar will indicate 
GNSS Universal Driver: Off, the Connect button will be displayed and the 
Profile list box will be enabled. 

 

 

If the GNSS Universal Driver is currently running and was started by the GNSS 
Control Panel, then the Disconnect button will be displayed. The status bar will 
either show GNSS Universal Driver Connecting… or the satellite status 
information: 

 

 

If the GNSS Universal Driver is currently running but was started by an 
application other than the GNSS Control Panel (such as the GNSS Driver for 
ArcPad), then no button will be displayed. 

 

This means that the GNSS Universal Driver session is currently owned by that 
other application. See the next section about session ownership. 
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2.2 Viewing the Driver Current Owner and Clients 
The GNSS Universal Driver runs as a background process that may be shared among multiple applications. The 
first application to start the driver takes ownership of the driver. This means that it has access to all the capabilities 
of the driver, including recording of the GNSS data files used for post-processing (GPS, OBS and ORB). 

Other applications do not own the driver session, yet they have access to the GNSS position and status 
information. However they cannot record the GNSS data files for post-processing. 

Here is how to view which application is the owner. 

 

 

Click the Service tab. Click the Advanced tab: 

 

The name of the owner application, if there is 
one, will be displayed under GNSS Data 
Collector. This means that this application is 
allowed to record GNSS data for post-
processing. 

 

 

 

Select the Collect tab. 

Note that while another application (such as 
GNSS Driver for ArcPad) is owner, the Collect 
tab will not allow you to collect data until the 
owner application is stopped. 

  

 

When the driver is not in use, the GNSS Data 
Collector field will not be shown. 

This means that you are free to start the GNSS 
Universal Driver using the Connect button on 
the first page of the Service tab, as described in 
the next section. 

When there is no owner but 
the GNSS Control Panel is 
connected to the receiver, the 
following is shown in the 
Advanced page. The End 
Driver button is explained later 
in this chapter. 

 

Any other client(s) not owning 
the session will be listed under 
a list labeled Additional 
clients. 



 

 
OnPOZ.com 6 GNSS Control Panel

 
User Guide 

GNSS Control Panel // Precision Positioning Platform 

User Guide 

2.3 Connecting to the GNSS Receiver 
Once you have selected the appropriate GNSS receiver profile you are ready to connect to your GNSS receiver. 

Note to ArcPad Users 

Refer to the GNSS Driver for ArcPad User Guide for connecting to the GNSS receiver in ArcPad. The procedure 
described here applies only to connecting using the GNSS Control Panel. 

 

 

Click the Service tab. Click the first tab: 

 

Select the appropriate GNSS receiver profile from 
the list. 

Power on your GNSS receiver. 

Click the Connect button. 

 

 

This starts the GNSS Universal Driver, which 
goes into the Loading… state, followed by 
Listening… 

After a few seconds the status bar will indicate 
GNSS Universal Driver: Connecting… 

 

 

 

Once the GNSS Universal Driver is receiving at 
least 4 satellites, the status bar will display the 
satellites information and the current GNSS 
position will be shown. 

TROUBLESHOOTING TIPS 

If the status remains GNSS Universal Driver: 
Connecting… for too long, then try these: 

• Make sure the GNSS receiver is powered on 
and correctly connected (Bluetooth, USB or 
serial) to the computer. 

• Make sure that you are using an appropriate 
profile. For instance, are you using the proper 
protocol and baud rate ? 

• Make sure that the antenna is attached to 
your GNSS receiver and has a clear view of 
the sky. Wait a few minutes for your receiver 
to compute a position fix. 

The status bar will indicate 
Acquiring satellites… 
whenever the connection is 
established but the satellite 
signal is too weak or missing. 
Check your antenna then. 
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2.4 Disconnecting from the GNSS Receiver 
You can stop the GNSS Universal Driver from the GNSS Control Panel. 

 

 

Click the Disconnect button to terminate the 
connection with the GNSS receiver. 

Note that if you have started a data collection 
using the Collect tab, you will not be able to 
disconnect, and the following message will be 
displayed when you click Disconnect: 

 

 

 

If the GNSS Universal Driver was started by 
another application, the Connect button will not 
show. 

In this case you can use the Advanced tab to 
view which application owns the driver, and then 
close that application in order to stop the driver. 

 

 

 

If you cannot stop the GNSS Universal Driver 
using the above methods, then you can use the 
End Driver button to force the driver to stop. 

IMPORTANT: Use this option only if there is 
no other way to cleanly stop the driver.  

You can also use File > Exit to 
quit the application. This will 
automatically disconnect from 
the driver. 

 

 

Note that if a data collection is 
running in the Collect tab, you 
will be asked the following 
question: 

 

Click Yes to save and exit or 
No to continue without exiting. 



 

 
OnPOZ.com 8 GNSS Control Panel

 
User Guide 

GNSS Control Panel // Precision Positioning Platform 

User Guide 

2.5 Using the Status Bar to Monitor the GNSS Status 
The status bar provides a quick summary of the status of the GNSS satellites. The status bar is available under the 
Service and Connect tabs 

 

 When the GNSS Universal Driver is not running, 
the text GNSS Universal Driver: Off is displayed 
in the status bar. 

 

 When the GNSS Universal Driver is running but 
is not connected or is not yet ready, the text 
GNSS Universal Driver: Connecting… is 
displayed in the status bar. 

 

 When the GNSS Universal Driver is ready but is 
yet not receiving GNSS positions from the 
receiver, the text Acquiring satellites… is 
displayed in the status bar. 

 

 When the GNSS Universal Driver is running and 
receiving GNSS positions, the status bar indicates 
the status of the GNSS satellites. 

 
The first indicator displays the number 
of satellites used to compute the 
GNSS position. 

 
The second indicator displays the 
position dilution of precision (PDOP). 
The lower the value, the more precise 
the position shall be. 

 
The third indicator displays the 
estimated 2D error in meters. 

 
The last indicator displays the type of 
GNSS solution used to compute the 
latest position. See sidebar for details. 

 
 

The solutions will be one of the 
following: 

 
GNSS – simple GNSS 
solution; 

SBAS – solution aided with 
SBAS corrections; 

DGNSS – solution aided with 
differential GNSS corrections. 

 

If your receiver supports both 
GPS and GLONASS, the 
satellites count will include the 
sum of GPS and GLONASS 
satellites used. 

 

TROUBLESHOOTING TIPS 

If the status remains GNSS 
Universal Driver: 
Connecting… for too long, 
then try these: 

• Make sure the GNSS 
receiver is powered on 
and correctly connected 
(Bluetooth, USB or serial) 
to the mobile computer. 

• Make sure that you are 
using an appropriate 
profile. For instance, are 
you using the proper 
protocol and baud rate? 

• Make sure that the 
antenna is attached to 
your GNSS receiver and 
has a clear view of the 
sky. Wait a few minutes 
for your receiver to 
compute a position fix. 
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3 Collecting GNSS Data for Post-Processing 
This chapter explains how to collect kinematic, base and static data using the GNSS Control Panel and shows 
how to post-process the collected data with EZSurv®. 

 

A Note to ArcPad Users 

Users of the GNSS Driver for ArcPad may skip this chapter, unless also interested in collecting GNSS data 
using the GNSS Control Panel. ArcPad users should read the GNSS Driver for ArcPad User Guide. 
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3.1 Collecting Kinematic GNSS Data 
You can use the GNSS Control Panel to collect kinematic data as you walk in the field. The collected data is 
ready to be post-processed with EZSurv®. 

Start the GNSS Universal Driver and make sure that you are receiving signal before you start the data 
collection. See chapter 2 for details about starting the driver. 

 

 

 

Select the Collect tab and select Kinematic from 
the list. 

• Use the File field to edit the default file 
name if needed. 

• Select a data collection interval from the 
Interval list; 

• Use the Antenna height field to enter the 
antenna height. The combo after the edit 
box lets you choose the unit for antenna 
height. 

Click Start to start the data collection. 

 

 

The Stop button is displayed and the fields are 
grayed-out while data is being collected. 

 

Click Stop to terminate the data collection and to 
close the collected data files. 

Click Yes to confirm or No to continue with the 
data collection. 

 

 

Once you have stopped the data collection, you 
will find the collected GNSS files (GPS, OBS, 
ORB and POS) in your personal documents 
folder, under Effigis\GNSS Control Panel. Click 

 to see the exact folder name. 

See the sidebars for sample folders on Windows 
Mobile and Windows. 

Windows Mobile: 

\My Documents\Effigis\GNSS 
Control Panel 

 

Windows XP (example): 

C:\Documents and 
Settings\MyUser\My 
Documents\Effigis\GNSS 
Control Panel 

 

Windows Vista, Windows 7, 
Windows 8, Windows 8.1 and 
Windows 10 (example): 

C:\Users\MyUser\Documents\ 
Effigis\GNSS Control Panel 

 

 

A kinematic data collection will 
contain all the GNSS 
observations (and real-time 
computed positions) collected 
on the field. 

 

Click the  button to see the 
folder name where the data 
files are collected. 
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3.2  Collecting Base and Static GNSS Data 
You can use the GNSS Control Panel to collect base and static data as the GNSS antenna stands still on the 
field. The collected base and static data is ready to be post-processed with EZSurv®. 

Start the GNSS Universal Driver and make sure that you are receiving signal before you start the data 
collection. See chapter 2 for details about starting the driver 

 

 

Select the Collect tab and select Base or Static 
from the list. 

• Use the File field to edit the default file 
name if needed. 

• Select a data collection interval from the 
Interval list; 

• Use the Antenna height field to enter the 
antenna height. The combo after the edit 
box lets you choose the unit for antenna 
height. 

• Use the Site (mandatory) and Code 
(optional) fields to enter the site and code 
information for your base or static project. 

Click Start to start the data collection. 

IMPORTANT: Secure the antenna in stable 
position before starting the project. The 
antenna must not move during the collection 
of a base or static project. 

 

 

The Stop button is displayed and the fields are 
grayed-out while data is being collected. 

Click Stop to terminate the data collection and to 
close the collected data files. 

Click Yes to confirm or No to continue with the 
data collection. 

 

 

Once you have stopped the data collection, you 
will find the collected GNSS files (GPS, OBS and 
ORB) in your personal documents folder, under 

Effigis\GNSS Control Panel. Click  to see the 
exact folder name. 

See the sidebars for sample folders on Windows 
Mobile and Windows. 

Use Base to collect a 
reference base for post-
processing static and kinematic 
projects. EZSurv® will ask for 
the coordinates of the base. 

Use Static to survey a static 
location on the field. 

 

Windows Mobile: 

\My Documents\Effigis\GNSS 
Control Panel 

 

Windows XP (example): 

C:\Documents and 
Settings\MyUser\My 
Documents\Effigis\GNSS 
Control Panel 

 

Windows Vista, Windows 7, 
Windows 8, Windows 8.1 and 
Windows 10 (example): 

C:\Users\MyUser\Documents\E
ffigis\GNSS Control Panel 

 

 

Click the  button to see the 
folder name where the data 
files are collected. 
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3.3 Post-processing GNSS Data with EZSurv® 
Transfer the GNSS data from the field and use EZSurv® to post-process the data. 

 

IMPORTANT: We strongly recommend you read the EZSurv® User Guide for an in-depth description of 
GNSS post-processing with EZSurv®. 

. 

 

 

You can use Mobile File Manager in OnPOZ 
Tools to transfer your GNSS data to the computer 
running EZSurv®. Or you can copy manually the 
GPS, OBS, ORB and POS files from your mobile 
computer to the computer running EZSurv®. 

 

 

 

Drag and drop the GPS file to the EZSurv® 
Observations folder to open the GPS file. 

 

 

 

For base projects you will be asked to enter the 
coordinates of the base. 

 

 

 

Use Tools > Process Auto… or Tools > 
Process Manual to post-process the GNSS data. 

Please refer to the EZSurv® documentation for 
details. 

 

Select File > Save to save the post-processed 
project. 

Use the Site Editor to enter 
the coordinates of the base. 

 

The POS file is present only for 
Kinematic projects. 
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4 Creating and Editing GNSS Receiver Profiles 
This chapter explains how to create and edit GNSS receiver profiles that contain all the parameters needed to 
connect to your GNSS receiver. The GNSS Control Panel come with a number of preset profiles, but you can 
create your own if the profile you need is not part of the presets. 

 

� About GNSS Receiver Profiles 

A GNSS receiver profile contains the following parameters needed to connect to your GNSS receiver: 

• Protocol. This may be any vendor-specific GNSS protocol supported by the GNSS Universal Driver; 

• Connection parameters: port number, baud rate, flow control and DTR. 

 

A profile also contains additional parameters that are seldom needed, and reserved for advanced uses: 

• Initialization string. This is useful in order to perform custom initializations of the GNSS receiver. In 
most cases this is not needed because the GNSS Universal Driver properly initializes the GNSS 
receivers for the most useful scenarios. You must know the details about the protocol of your receiver in 
order to set the initialization string. 

• Advanced parameters. Some advanced parameters can be configured where the standard parameters 
will not do. The most useful advanced parameters are documented in this guide. 

 

� Preset Profiles 

The GNSS Control Panel includes a number of preset profiles that you can use but that you cannot edit. In many 
cases the presets will do the job and you will not have to create nor edit your own profiles. There is at least one 
preset for each supported protocol. 

 

� User Profiles 

If there is no preset profile containing the parameters needed for your GNSS receiver, you can create a new user 
profile or edit a copy of one of the presets as a new user profile. This is useful for instance when you need to 
select a specific COM port for using your receiver over Bluetooth. 
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� The XGDP Files 

All profiles are saved in files with the XGDP extension under your computer’s application folder. The exact 
location on Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1 or Windows 10 may vary, but it 
corresponds to the Effigis\GNSS Profiles folder under the application data folder for the current user. Typical 
folders will be as follows: 

 

• Windows Mobile: \Application Data\Effigis\GNSS Profiles; 

• Windows XP: C:\Documents and Settings\MyUser\Application Data\Effigis\GNSS Profiles; 

• Windows Vista, Windows 7, Windows 8, Windows 8.1 or Windows 10: 
C:\Users\MyUser\AppData\Roaming\Effigis\GNSS Profiles; 

 

IMPORTANT: Do not edit the XGDP files manually. 

The protocols.xgdp and presets.xgdp are distributed and updated by the GNSS Control Panel 
installation program. They are never modified by the GNSS Control Panel. 

The user.xgdp file initially contains no profiles. It is modified by the GNSS Control Panel. You 
should include the user.xgdp file as part of your backups. 
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4.1 Creating a New User Profile 
If you cannot find a preset profile that fits your need you can create a new user profile. 

 

 

 

Select the Profiles tab, then select the profile 
selection page: 

 

Click New… 

Enter the name for the new profile and click OK. 

 

 

This opens the profile edition page. 

 

Select the parameters for this profile: 

• Protocol: select one of the available 
GNSS protocols from the list; 

• Port: select the communication port from 
the list; 

• Baud: select the baud rate from the list; 

• Flow: select a flow control option from the 
list; 

• DTR: enable or disable the DTR. 

 

 

Click the folder icon: 

 

Select Save Profiles from the menu to save the 
changes to the profiles. 

REMARK 

If needed, you can use the Revert to Saved 
Profiles menu to undo all changes and thus revert 
to the last saved version of the profiles.  

Use the Service tab to test the connection using 
this profile. 

Baud rates are restricted to 
what is supported by the 
GNSS Universal Driver for the 
selected protocol. 
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4.2 Editing an Existing User Profile 
This section shows how to edit an existing user profile. 

 

 

 

Select the Profiles tab, then select the profile 
selection page: 

 

 

Select the user profile to edit from the list. 

 

 

Select the profile edition page. 

 

Edit the parameters. 

REMARK 

If you have selected a preset profile, then you will 
not be able to edit its parameters. Preset profiles 
cannot be edited. 

 

 

Click the folder icon: 

 

Select Save Profiles to save your changes, or 
Revert to Save Profiles to undo the changes. 

 

Use the Service tab to test the connection using 
this profile. 
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4.3 Creating a New User Profile from a Copy of an Existing Profile 
You can create a new profile by using an existing user or preset profile as a model. This is useful for instance 
when you want to make multiple copies of a profile to account for various possible Bluetooth or USB ports. 

 

 

Select the Profiles tab, then select the profile 
selection page: 

 

 

Select a profile from which you want to create a 
new copy. 

Click New Copy… 

Enter the name for the new profile and click OK. 

 

 

 

Edit the parameters and save. 

Use the Service tab to test the connection using 
this profile. 
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4.4 Deleting a User Profile 
You can delete a user profile if you do not need it anymore. 

 

 

Select the Profiles tab, then select the profile 
selection page: 

 

 

Select the profile to delete. 

Click Delete. 

 

REMARK 

The Delete button is enabled only if the selected 
profile is a user profile. You cannot delete a preset 
profile. 

 

 

Click Yes to confirm the deletion and then save. 

 



 

 
OnPOZ.com 19 GNSS Control Panel

 
User Guide 

GNSS Control Panel // Precision Positioning Platform 

User Guide 

4.5 Publishing User Profiles Only 
By default, both the user and the preset profiles are published for selection by end-user when he chooses a 
profile for connection with his GNSS receiver. 

Since most users need only a limited set of profiles, you can restrict the publication of the profiles strictly to the 
user profiles. This way the preset profiles will be hidden. 

For instance if you are using only SubX receivers, create user profiles for those receivers then hide the preset 
profiles. This way the end-user will not see the other brands of receivers. 

 

 

 

Select the Profiles tab, then select the profile 
selection page: 

 

 

Uncheck the Publish presets box to publish only 
your user profiles. 

 

 

With Publish presets unchecked, the Service tab 
will show only the user profiles. 

 

You can check the Publish 
presets box if you want to 
publish both the presets and 
the user profiles. 
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4.6 Creating a Playback Profile 
This section shows how to use the advanced page to create a special GNSS profile that reads the GNSS data 
from a playback file, instead of from a GNSS receiver. This is useful for demo and training purposes. The 
playback file can be collected using the GNSS Driver for ArcPad or any other application capable of collecting 
playback files. 

 

 

Select the Profiles tab, then select the profile selection 
page: 

 

Click New… 

Enter the name Playback for the new profile. 

 

Click OK. 

 

 

 

Select the protocol that matches your playback file. 

 

Note: All the other parameters (Port, Baud rate, Flow, Init 
string and DTR) will be ignored when using playback. 

 

 

Select the advanced page: 

 

 

Enter the following information: 

• Section: PLAYBACK 

• Param: PLAYBACKFILE 

• Value: enter the full name of the playback file. For 
instance: C:\data\09028GNSSC.in.bin 

 

Click Add. 

The PLAYBACKFILE 
parameter in the PLAYBACK 
section specifies the name of 
the playback file to use. 

 

The PLAYBACKBPS 
parameter in the PLAYBACK 
section specifies the playback 
rate in bytes per second. 
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Enter the following information: 

• Section: PLAYBACK 

• Param: PLAYBACKBPS 

• Value: 2000 

 

Click Add. 

 

This adds advanded parameters to the profile, and lists the 
parameters at the bottom of the page. 

 

Save the profile. 

 

Use the Service tab to test the connection using this 
profile. 
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4.7 Copying Profiles to your Mobile Computers 
If you are using more than one mobile computer you may find it useful to edit and test the profiles once, then copy 
the same profiles to all mobile computers. 

 

 

All the profiles and protocols are saved in.XGDP 
files named protocols.xgdp, presets.xgdp and 
user.xgdp. These files are located in the GNSS 
Profiles folder (see sidebar). 

 

 Copy all three files to all the GNSS Profiles folder 
of the target mobile computers. 

 

IMPORTANT: Copy all three files. Otherwise 
you may end-up with a user.xgdp which is out 
of sync with presets.xgdp and 
protocols.xgdp. 

 

 IMPORTANT: Never modify the presets.xgdp 
and protocols.xgdp files. 

It is not recommended to modify the user.xgdp 
file manually: use the GNSS Control Panel to 
edit the user profiles. 

 

The GNSS Profile Folder 

The exact location on Windows 
XP, Windows Vista, Windows 
7, Windows 8, Windows 8.1 
and Windows 10 may vary, but 
they correspond to the 
Effigis\GNSS Profiles folder 
under the application data 
folder for the current user. 
Typical folders will be as 
follows: 

 

Windows Mobile: 

\Application Data\Effigis\GNSS 
Profiles 

 

Windows XP: 

C:\Documents and 
Settings\MyUser\Application 
Data\Effigis\GNSS Profiles 

 

Windows Vista, Windows 7, 
Windows 8, Windows 8.1 and 
Windows 10: 
C:\Users\MyUser\AppData\ 
Roaming\Effigis\GNSS Profiles 
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